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1	 Informações 
importantes de 
segurança

Manutenção geral
A tradução deste documento é apenas uma 
referência. 
Em caso de inconsistência entre a versão em 
inglês e a versão traduzida, a versão em inglês 
deverá prevalecer.
 

Cuidado

Para evitar danos ou defeitos••
Não o exponha o produto a calor excessivo ••
causado pela luz solar direta ou por 
equipamentos que emitem calor.
Não deixe o produto cair nem deixe objetos ••
caírem no aparelho.
Não mergulhe o produto na água. Não ••
exponha a entrada para fone de ouvido ou 
o compartimento de pilhas à água, pois isso 
pode danificar seriamente o aparelho.
Telefones celulares ativos nas proximidades ••
podem causar interferência. 
Faça backup dos seus arquivos. Não deixe ••
de guardar uma cópia dos arquivos originais 
baixados no dispositivo. A Philips não é 
responsável por qualquer perda de dados se o 
produto for danificado ou se tornar ilegível. 
Gerencie (transfira, exclua etc.) seus arquivos ••
de música somente com o software de música 
fornecido para evitar problemas.
Não utilize agentes de limpeza que contenham ••
álcool, amônia, benzina ou abrasivos, pois eles 
podem danificar o produto.

 
Sobre as temperaturas de operação e 
armazenamento

Utilize o aparelho em um local cuja •	
temperatura esteja sempre entre 0 e 
35°C
Armazene-o em um local cuja •	
temperatura esteja sempre entre -20 e 
45°C.

A vida útil das pilhas pode ser reduzida •	
em condições de baixa temperatura.

 
Peças/acessórios de reposição:
Visite www.philips.com/support para obter 
peças/acessórios de reposição.
 
Como ouvir música com segurança

Ouça a um volume moderado:
O uso de fones de ouvido com volume alto 
pode prejudicar sua audição. Este produto pode 
emitir sons em faixas de decibéis que podem 
causar perda de audição em pessoas, mesmo 
que expostas por menos de 1 minuto. As faixas 
de decibéis mais altas são oferecidas para 
pessoas que apresentam perda auditiva.
É muito fácil se enganar com o volume do 
som ideal. Ao longo do tempo, o “nível de 
conforto” da audição se adapta a volumes 
mais altos. Portanto, após ouvir músicas por 
um período prolongado, o volume que parece 
“normal” pode, na verdade, ser alto e prejudicial 
à audição. Para que isso não ocorra, ajuste o 
volume para um nível seguro antes que sua 
audição se adapte e mantenha-o assim.
Para estabelecer um nível de volume seguro:
Ajuste o controle de volume para um nível 
baixo.
Aumente lentamente o som até ouvi-lo de 
maneira confortável e clara, sem distorção.
Ouvir músicas por períodos prolongados:
A exposição prolongada ao som, mesmo em 
níveis normalmente “seguros”, também pode 
causar perda auditiva.
Certifique-se de usar controladamente o 
equipamento e faça pausas freqüentes.
Observe as seguintes diretrizes ao usar os fones 
de ouvido.
Ouça com volume moderado e por períodos 
razoáveis de tempo.
Tome cuidado para não aumentar o volume à 
medida que sua audição for se adaptando.



4 PT-BR

Não aumente o volume de modo que não 
consiga ouvir as pessoas ao seu redor.
Você deve tomar cuidado ou interromper 
temporariamente o uso em situações de perigo 
em potencial.
Não use fones de ouvido ao pilotar um veículo 
motorizado, andar de bicicleta, skate etc. Isso 
pode ser perigoso no trânsito e é ilegal em 
muitos locais. 
Modificações
Modificações não autorizadas pelo fabricante 
poderão anular a autoridade do usuário para 
operar este dispositivo.
 Informações sobre direitos autorais
Todas as outras marcas e nomes de produtos 
são marcas registradas de suas respectivas 
empresas e organizações.
A cópia e distribuição não autorizadas de 
quaisquer gravações baixadas da Internet ou 
feitas usando-se CDs de áudio é uma violação 
da lei de direitos autorais e de tratados 
internacionais.
A criação de cópias não autorizadas de 
materiais protegidos contra cópia, incluindo 
programas de computador, arquivos, 
transmissões e gravações sonoras, pode 
representar uma violação a direitos autorais e 
constitui um crime. Este equipamento não deve 
ser usado para tais propósitos.
Windows Media e o logotipo Windows são 
marcas comerciais ou marcas registradas da 
Microsoft Corporation nos Estados Unidos e/
ou outros países. 
Seja responsável. Respeite os direitos autorais.

A Philips respeita a propriedade intelectual 
das pessoas e pede que seus usuários façam o 
mesmo. 
O conteúdo multimídia na Internet pode ter 
sido criado e/ou distribuído sem a autorização 
do proprietário original dos direitos autorais. 
A cópia ou distribuição não autorizada do 
conteúdo pode violar leis de direitos autorais 
de vários países, inclusive o seu. 
Você é o responsável pelo cumprimento das 
leis de direitos autorais.

A gravação e a transferência para o aparelho 
portátil de transmissões de vídeo baixadas para 
o computador destinam-se exclusivamente a 
conteúdo de domínio público ou devidamente 
licenciado. Esse conteúdo destina-se ao uso 
próprio e não-comercial, e você deve respeitar 
eventuais instruções de direitos autorais 
fornecidas pelo respectivo proprietário da 
obra. Essas instruções podem determinar que 
nenhuma cópia adicional deverá ser feita. As 
transmissões de vídeo podem incluir tecnologia 
de proteção contra cópia que proíba cópias. 
Nesses casos, o recurso de gravação não 
funcionará e você será notificado com uma 
mensagem. 
Registro de dados
A Philips está empenhada em melhorar a 
qualidade de seus produtos e em aprimorar 
a experiência de seus usuários. Para entender 
o perfil de utilização deste dispositivo, ele 
registra algumas informações/dados na região 
da memória não volátil. Esses dados são usados 
para identificar e detectar falhas ou problemas 
que você, usuário, pode ter ao usar o dispositivo. 
Os dados armazenados, por exemplo, informam 
a duração da reprodução no modo de música 
ou no modo sintonizador, quantas vezes a bateria 
ficou descarregada etc. Os dados armazenados 
não revelam o conteúdo ou a mídia usada 
no dispositivo nem a origem dos downloads. 
Os dados armazenados no dispositivo serão 
recuperados e usados SOMENTE se o usuário 
encaminhar o dispositivo para a Assistência 
Técnica Autorizada da Philips e SOMENTE para 
simplificar a detecção e a prevenção de erros. Os 
dados armazenados devem ser imediatamente 
disponibilizados para o usuário mediante sua 
solicitação.

 

Nota

 • os textos em inglês a seguir são parte da
obrigação da Philips com desenvolvedores de
software aberto usado neste produto ou
programas relacionados. Não se dirigem ao
consumidor. Caso deseje informações sobre o
assunto, contate: “Open Source Team, Philips
Intellectual Property & Standards, P.O. Box
220, 5600 AE Eindhoven, The Netherlands.” 
Se você não receber a confirmação da sua
carta, envie um email para o endereço:
open.source@philips.com.
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Monkey’s Audio decoder

a	 The Monkey’s Audio SDK and source 
code can be freely used to add 
APE format playback, encoding, or 
tagging support to any product, free 
or commercial. Use of the code for 
proprietary efforts that don’t support 
the official APE format require written 
consent of the author.

b	 Monkey’s Audio source can be included 
in GPL and open-source software, 
although Monkey’s Audio itself will 
not be subjected to external licensing 
requirements or other viral source 
restrictions.

c	 Code changes and improvements must 
be contributed back to the Monkey’s 
Audio project free from restrictions or 
royalties, unless exempted by express 
written consent of the author.

d	 Any source code, ideas, or libraries used 
must be plainly acknowledged in the 
software using the code.

e	 Although the software has been tested 
thoroughly, the author is in no way 
responsible for damages due to bugs or 
misuse.

If you do not completely agree with all of the 
previous stipulations, you must cease using this 
source code and remove it from your storage 
device.
 
FLAC decoder
Copyright (C) 2000,2001,2002,2003,2004,2005,
2006,2007,2008,2009 Josh Coalson
 
Redistribution and use in source and binary 
forms, with or without modification, are 
permitted provided that the following 
conditions are met:

Redistributions of source code must •	
retain the above copyright notice, this list 
of conditions and the following disclaimer.

Redistributions in binary form must •	
reproduce the above copyright notice, 
this list of conditions and the following 
disclaimer in the documentation and/
or other materials provided with the 
distribution.
Neither the name of the Xiph.org •	
Foundation nor the names of its 
contributors may be used to endorse 
or promote products derived from this 
software without specific prior written 
permission.

 
THIS SOFTWARE IS PROVIDED BY 
THE COPYRIGHT HOLDERS AND 
CONTRIBUTORS “AS IS” AND ANY EXPRESS 
OR IMPLIED WARRANTIES, INCLUDING, 
BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE 
ARE DISCLAIMED. IN NO EVENT SHALL 
THE FOUNDATION OR CONTRIBUTORS 
BE LIABLE FOR ANY DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, 
BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS 
OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED 
AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, 
OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT 
OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE.
 
XPAT XML Parser
Copyright (c) 1998, 1999, 2000 Thai Open 
Source Software Center Ltd
 
Permission is hereby granted, free of charge, to 
any person obtaining a copy of this software 
and associated documentation files (the 
“Software”), to deal in the Software without 
restriction, including without limitation the rights 
to use, copy, modify, merge, publish, distribute, 
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sub-license, and/or sell copies of the Software, 
and to permit persons to whom the Software 
is furnished to do so, subject to the following 
conditions:
 
The above copyright notice and this permission 
notice shall be included in all copies or 
substantial portions of the Software.
THE SOFTWARE IS PROVIDED “AS IS”, 
WITHOUT WARRANTY OF ANY KIND, 
EXPRESS OR IMPLIED, INCLUDING BUT 
NOT LIMITED TO THE WARRANTIES 
OF MERCHANTABILITY, FITNESS FOR 
A PARTICULAR PURPOSE AND NON-
INFRINGEMENT. IN NO EVENT SHALL THE 
AUTHORS OR COPYRIGHT HOLDERS 
BE LIABLE FOR ANY CLAIM, DAMAGES 
OR OTHER LIABILITY, WHETHER IN AN 
ACTION OF CONTRACT, TORT OR 
OTHERWISE, ARISING FROM, OUT OF OR 
IN CONNECTION WITH THE SOFTWARE 
OR THE USE OR OTHER DEALINGS IN THE 
SOFTWARE.

Reciclagem do produto e da 
bateria interna
Seu produto foi projetado e fabricado com 
materiais e componentes de alta qualidade, que 
podem ser reciclados e reutilizados. 
Nunca descarte o seu produto junto com 
outros tipos de lixos domésticos. Procure 
informar-se a respeito das regras locais 
de coleta seletiva de produtos elétricos e 
eletrônicos e de pilhas/baterias. 
O descarte correto desses produtos ajuda a 
prevenir conseqüências potencialmente negativas 
para o meio ambiente e para a saúde humana.
Visite www.recycle.philips.com para obter mais 
informações sobre o centro de reciclagem mais 
próximo.

Cuidado

A remoção da bateria interna anulará a ••
garantia e poderá destruir o produto. 

 �Philips 
SA2VBE04 SA2VBE08 SA2VBE16 

Aviso para os EUA
Este equipamento foi testado e cumpre os 
limites para um dispositivo digital de Classe 
B, de acordo com a parte 15 das Normas da 
FCC. Esses limites têm por objetivo fornecer 
uma proteção adequada contra interferência 
prejudicial em instalações residenciais. Este 
equipamento gera, utiliza e pode irradiar 
energia de radiofreqüência e, se não for 
instalado e usado de acordo com o manual 
de instruções, poderá provocar interferência 
prejudicial a comunicações via rádio.
No entanto, não há garantia de que tal 
interferência não venha a ocorrer em 
determinadas instalações. Se este equipamento 
provocar interferência prejudicial a receptores 
de rádio ou televisão, o que pode ser 
determinado desligando-se e ligando-se o 
equipamento, o usuário poderá tentar corrigir 
a interferência por meio de uma ou mais das 
seguintes medidas:

Reposicione a antena receptora.•	
Aumente a distância entre o •	
equipamento e o receptor.
Conecte o equipamento a outra tomada, •	
ligada a uma fase diferente da que 
alimenta o receptor.
Consulte o fornecedor ou um técnico •	
experiente em rádio/TV para obter ajuda.

 
Aviso para o Canadá
Este equipamento digital da Classe B está em 
conformidade com a ICES-003 do Canadá.
Este equipamento está em conformidade com 
a Parte 15 das Normas da FCC-e com a 21 
CFR 1040.10. A operação está sujeita a estas 
duas condições:

Este dispositivo não pode causar •	
interferência prejudicial e
Este dispositivo deve aceitar qualquer •	
interferência recebida, incluindo 
interferência que possa causar operação 
indesejada.
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2	

reproduzir músicas•	
assistir a vídeos•	
ouvir rádio FM•	
fazer gravações•	

Conteúdo da caixa
Verifique se você recebeu os seguintes itens:
Player

Fones de ouvido

Cabo USB

  
Guia de Início Rápido

 
Nota

As imagens servem apenas como referência. ••
A Philips se reserva o direito de alterar a cor/
design sem notificação prévia.

Philips GoGear audio player

Quick start guide

Seu novo SA2VBE
Com o SA2VBE, você pode:
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3	 Primeiros 
passos

Visão geral de controles e 
conexões

a tela
b  / na tela de reprodução, pressione 

para aumentar/diminuir o volume
na tela de reprodução, pressione 
e segure para aumentar/diminuir 
rapidamente o volume

c exibe o menu de opções
d  / pressione e segure para pular 

rapidamente para frente/trás
na tela de reprodução, pressione 
e segure para fazer uma 
pesquisa na faixa atual

e pressione para reproduzir/
pausar/confirmar

f MIC microfone
g entrada para fone de ouvido
h RESET
i deslize e mantenha a posição 

deslize para travar/destravar 
todos os botões

j  / em uma lista, pressione para 
rolar para cima/baixo
em uma lista, pressione e segure 
para rolar rapidamente para 
cima/baixo

k plugue do conector USB
l pressione para retornar um nível

pressione e segure para retornar 
ao menu raiz

Limitar volume

Cuidado

Sons altos ouvidos por um tempo maior ••
podem ser prejudiciais ao ouvinte.

limitar a altura máxima.
1	 No menu principal, selecione 

[Configurações] > [Definições de som] 
> [Limite de volume].

2	 Pressione os controles de volume  /  
para ajustar o volume.

3	 Pressione  para confirmar.
Quando um limite de volume é »»

excedê-lo, mesmo que você pressione 
o botão para aumentar o volume .

pressione para reinicializar o SA2VBE

para ligar/desligar o SA2VBE

Você pode ajustar o volume do SA2VBE para 

definido, o SA2VBE não pode mais 
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Para reativar o volume máximo:
1	 Selecione [Configurações] > [Definições 

de som] > [Limite de volume].
2	 Ajuste o limite de volume para o máximo.
3	 Pressione  para confirmar.

Visão geral do menu principal

Menu Modo Para
Música reproduzir faixas 

de áudio digital
Canais 
Rhapsody*

ouvir canais 
Rhapsody*

Vídeo reproduzir vídeos
Imagens exibir imagens
Rádio FM ouvir rádio FM
Gravações criar ou ouvir 

gravações
Visualizar pasta exibir arquivos em 

pastas
Configurações personalizar as 

configurações do 

Reproduzindo 
agora

mostrar a tela de 
reprodução atual

Nota

* Os canais Rhapsody se tornarão parte do ••
menu principal depois que você conectar 

Rhapsody instalado. Os serviços dos canais 
Rhapsody requerem uma conta do Rhapsody 
ativa e estão disponíveis somente em algumas 
regiões.

Conectar e carregar

carregada pela porta USB de um computador 
(cabo USB incluído).

Nota

••
computador, as seguintes opções serão 
apresentadas:

•• [Carregar e transferir] ou [Carregar e 
reproduzir].

••
[Carregar e transferir] se nenhuma seleção 
for feita.

1	 Conecte o plugue do cabo USB fornecido 
a uma porta USB livre em seu computador.

2	 Conecte o plugue pequeno do cabo USB 

3	 Ligue o computador.
»»

SA2VBE

o SA2VBE a um computador com o software 

O SA2VBE tem uma bateria interna que pode ser 

Quando você conectar o SA2VBE a um 

O SA2VBE executará automaticamente a opção 

Conectar o SA2VBE a um computador

à pequena entrada USB do SA2VBE.

O SA2VBE é carregado.
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Instalação inicial do Philips Songbird

uma janela pop-up será exibida:
1	 Selecione Install Philips Songbird.
2	 Siga as instruções da tela para fazer a 

instalação.

Nota

É necessário concordar com os termos de ••
licença para fazer a instalação.

Se a janela pop-up não for exibida 
automaticamente:
1	 Selecione Meu Computador (Windows 

XP / Windows 2000) / Computador 
(Windows Vista / Windows 7).

2	 Clique com o botão direito do mouse no 
Philips GoGear.

3	 Selecione Install Philips Songbird (Setup.
exe).

4	 Siga as instruções da tela para fazer a 
instalação.

Nota

É necessário concordar com os termos de ••
licença para fazer a instalação.

Reinstalar o software Philips Songbird 
(após a instalação inicial)
Importante!
O instalador do software Philips Songbird já 

para seu conteúdo de mídia, o arquivo do 
instalador é automaticamente excluído 
durante o processo de instalação inicial. 
Se você desejar instalar o software em outro 
momento, após a instalação inicial, siga estas 
instruções:
1	
2	 Certifique-se de que o computador 

esteja conectado à Internet e abra o 
Windows Explorer.

3	 No Windows Explorer, clique com 

selecione a opção para instalar o Philips 
Songbird.

O computador baixa da Internet o »»
arquivo do instalador.

4	 Siga as instruções da tela para fazer a 
instalação.

Ao conectar o SA2VBE ao PC pela primeira vez, 

ícone do SA2VBE

vem carregado no SA2VBE. 
Para liberar espaço na memória do SA2VBE

Conecte o SA2VBE ao computador.

o botão direito do mouse no SA2VBE e 
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Indicação do nível de carga da bateria
O display indica o nível aproximado do status 
da bateria da seguinte maneira:

100% 75% 50% 25% 0%

A imagem da pilha piscando indica »»
que o nível de carga está baixo. O 
player salva todas as configurações e 
desliga em 60 segundos.

Nota

Baterias recarregáveis têm um número ••
limitado de ciclos de carga. A vida útil da 
bateria e o número de ciclos de carga variam 
de acordo com o uso e as configurações.
A animação do carregamento pára e o ícone ••

 é exibido quando o carregamento é 
concluído.

Dica

Você pode poupar energia da bateria e ••

acessando  > [Config. display] > [Timer 
deslig. tela] e selecionando o menor ajuste do 
timer.

•	 Philips Songbird (ajuda a atualizar o 

de mídia).

Manual do Usuário•	
Perguntas freqüentes•	
Informações sobre segurança e garantia •	
mundial
Informações sobre a garantia mundial•	

 

aumentar o tempo de reprodução do SA2VBE

Software instalado no SA2VBE
O  SA2VBE vem com o software: 

firmware do SA2VBE e a transferir arquivos 

Arquivos incluídos no SA2VBE
Os seguintes arquivos estão incluídos no SA2VBE:
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4	

chamado firmware. Novas versões do firmware 
podem ter sido lançadas após sua aquisição do 

O software Philips Songbird pode usar o 
computador para verificar atualizações de 
firmware disponíveis na Internet.
Instale o Philips Songbird no computador 
(consulte o capítulo Instalar software) e siga as 
instruções de atualização (consulte o capítulo 
Verificar / atualizar o firmware manualmente).

Nota

Os arquivos de música não são afetados pela ••
atualização do firmware.

Verificar/atualizar firmware 
manualmente
1	 Verifique se o computador está 

conectado à Internet.
2	

a seção Conectar e carregar para obter 
instruções).

3	 No computador, clique em Iniciar > 
Programas > Philips > Philips Songbird 
para iniciar o aplicativo Philips Songbird.

4	 Selecione Tools > Updates
O »» Philips Songbird verifica se há 
atualizações e instala o novo firmware 
da Internet, se disponível.

5	 Siga as instruções na tela para atualizar o 

6	 Aguarde a conclusão da atualização e 

Após a atualização do firmware, o »»

para uso.

Atualizar o SA2VBE
O SA2VBE é controlado por um programa interno 

SA2VBE. Conecte o SA2VBE ao computador (consulte 

firmware do SA2VBE.

desconecte o SA2VBE do computador.

SA2VBE será reiniciado e estará pronto 
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5 Ligar e desligar 

1 Para ligar e desligar o aparelho, deslize e
mantenha na posição     por cerca de
2 segundos.

Desligamento automático

automático para economizar energia da bateria. 
Depois de 10 minutos no modo ocioso 
(quando nenhuma música está sendo 
reproduzida e nenhum botão é pressionado), o 

1 Pressione e segure  por cerca de 2 

Travar os botões

travamento para evitar operação acidental.
1 Para travar os botões durante a 

reprodução, mova o controle deslizante 
até a posição .

Todos os botões, exceto os de  »
volume, são travados e o display exibe 
um ícone de cadeado.

2 Para destravar os botões, mova o 
controle deslizante até a posição central.

o SA2VBE

O SA2VBE dispõe do recurso de desligamento 

SA2VBE desliga.

segundos para religar o SA2VBE.

O SA2VBE dispõe de um controle deslizante de 
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6	 Philips Songbird

O software Philips Songbird o ajuda a:
adquirir novas mídias (músicas e vídeos) •	
online
criar uma biblioteca de mídia•	
gerenciar sua biblioteca de mídia•	
reproduzir músicas e vídeos•	

•	
Ao iniciar o Philips Songbird pela primeira 
vez, escolha uma das seguintes opções para 
importar arquivos de mídia para a biblioteca do 
Songbird:

Import an existing iTunes library •	
(Importar uma biblioteca existente do 
iTunes)
Scan for media files in specific directories •	
(Pesquisar arquivos de mídia em 
diretórios específicos). (Você pode optar 
por monitorar uma pasta para que os 
arquivos adicionados ou excluídos dessa 
pasta sejam adicionados ou excluídos 
automaticamente da biblioteca de mídia 
do Songbird.)

Criar uma biblioteca de mídia
Use uma ou mais das seguintes opções para 
criar uma biblioteca de mídia com o Songbird:

Copiar um CD
Por padrão, o software Philips Songbird instala 
os seguintes complementos necessários para 
copiar um CD:

CD Rip Support•	
Gracenote Metadata Lookup Provider•	

Configurar as opções para cópia de 
CD
1	 No computador, inicie o programa 

Songbird.
2	 Selecione Tools > Options... 

(Ferramentas > Opções).
3	 Selecione a guia CD Rip e, em seguida, 

escolha as opções de cópia de CD.
4	 Clique em OK para confirmar.

Importar arquivos de mídia de um 
diretório
As etapas a seguir mostram como importar 
arquivos de mídia (músicas e vídeos) 
armazenados em outro local no computador 
ou na rede:
1	 No computador, inicie o programa 

Songbird.
2	 Na barra de ferramentas do Songbird, 

clique em File (Arquivo) e selecione 
Import Media... (Importar mídias).

3	 Selecione os arquivos de mídia (músicas e 
vídeos) e clique em OK.

Os arquivos de mídia adicionados são »»
listados na biblioteca de mídia.

Dica

Se você selecionar uma pasta que contenha ••
arquivos de música ou vídeo, o software 
verificará o conteúdo e adicionará todos os 
arquivos de música ou vídeo à biblioteca de 
mídia (títulos duplicados serão ignorados).

O  SA2VBE vem com o software Philips Songbird. 

sincronizar suas mídias com o SA2VBE
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Importar mídia do iTunes
1	 No computador, inicie o programa 

Songbird.
2	 Selecione Tools > Options... 

(Ferramentas > Opções).
3	 Na barra de ferramentas do Songbird, 

selecione a guia Media Importer e, em 
seguida, iTunes Import/Export.

4	 Verifique o local da biblioteca e as opções 
da biblioteca.

5	 Selecione Import Library.
O software importa a biblioteca do »»
iTunes para o Songbird.

Exportar mídia para o iTunes
1	 No computador, inicie o programa 

Songbird.
2	 Selecione Tools > Options... 

(Ferramentas > Opções).
3	 Na barra de ferramentas do Songbird, 

selecione a guia Media Importer e, em 
seguida, iTunes Import/Export.

4	 Verifique o local da biblioteca e as opções 
da biblioteca.

5	 Selecione Export Library.
O software exporta a biblioteca do »»
Songbird para o iTunes.

Obter conteúdo de origens on-line
Você pode adquirir conteúdo de origens on-
line como:

7-digital•	

saber quais são os serviços disponíveis.

1	 No computador, inicie o programa 
Songbird.

2	 Na barra de ferramentas do Songbird, 
clique em File (Arquivo) e selecione 
Import Media... (Importar mídias).

3	
em OK.

As gravações selecionadas são listadas »»
na biblioteca de mídia.

Dica

Se você selecionar uma pasta que contenha ••
gravações, o software verificará o conteúdo 
e adicionará todas as gravações à biblioteca 
(títulos duplicados serão ignorados).

Navegar pela biblioteca de 
mídia
A estrutura da biblioteca de mídia do Songbird 
é a seguinte:

a	

b	 Painel da biblioteca (onde você encontra 
o conteúdo da biblioteca)

c	 Painel de serviços (onde você encontra 
informações adicionais sobre o conteúdo, 
como playlists)

Verifique as especificações do seu SA2VBE para 

Importar arquivos do SA2VBE

Selecione as gravações no SA2VBE e clique 

Painel do player (onde o SA2VBE é exibido)
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d	 Painel de informações (onde você 
encontra informações sobre as opções 
selecionadas)

Deixe o Songbird gerenciar suas 
mídias
1	 No computador, inicie o programa 

Songbird.
2	 Selecione Tools > Options… 

(Ferramentas > Opções) 
3	 Na barra de ferramentas do Songbird, 

selecione a guia Manage Files (Gerenciar 
arquivos).

4	 Marque Allow Songbird to manage my 
files (Permitir que o Songbird gerencie 
meus arquivos).

5	 Defina as opções para organizar as mídias 
de acordo com suas preferências.

Remover arquivos de mídia da 
biblioteca de mídia do Songbird
1	 Na biblioteca do Songbird, clique com o 

botão direito do mouse em um arquivo 
de mídia e selecione Remove (Remover).

2	 Na mensagem exibida, clique em Remove 
(Remover) para confirmar a remoção do 
arquivo.

O arquivo selecionado é removido »»
da biblioteca e de todas as playlists. 
(Por padrão, o arquivo é apenas 
“removido”, e não “excluído”. O 
arquivo de mídia permanece no local 
original do computador ou da rede.)

Dica

Para selecionar vários arquivos no computador ••
(PC), pressione e segure Ctrl.
Para selecionar vários arquivos consecutivos, ••
pressione e segure Shift .

Excluir mídia
Este é o procedimento para excluir arquivos 
de mídia no Windows Explorer:
1	

abra o Windows Explorer.
2	
3	 Exclua o arquivo de mídia como 

normalmente faz no computador.

Deixe o Songbird monitorar uma 
pasta
Você pode deixar que o Songbird

monitore o conteúdo de uma pasta e•	
adicione ou remova as mídias da sua •	
biblioteca de acordo com o conteúdo da 
pasta.

1	 No computador, inicie o programa 
Songbird.

2	 Selecione Tools > Options... 
(Ferramentas > Opções).

3	 Na barra de ferramentas do Songbird, 
selecione a guia Media Importer 
(Importador de mídias) e Watch Folders 
(Monitorar pastas).

4	 Selecione a pasta desejada para que o 
Songbird monitore as alterações.

A pasta selecionada é monitorada, e »»
o Songbird compara o conteúdo da 
biblioteca com o da pasta.

Com o SA2VBE conectado ao computador, 

Localize a pasta de mídia no SA2VBE.
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Buscar capa do álbum
Escolha uma destas opções para buscar capas 
de álbuns:
1	 No computador, inicie o programa 

Songbird.
Na barra de ferramentas do •	
Songbird, selecione Tools > Get 
Album Artwork.
Se nenhum título for selecionado, o »»
Songbird buscará a capa de todos os 
títulos da biblioteca.
Clique com o botão direito do •	
mouse nos títulos selecionados.
O Songbird busca a capa de todos os »»
títulos selecionados.

Playlists
Por padrão, o software Philips Songbird instala 
os seguintes complementos necessários para 
copiar um CD:

CD Rip Support•	
Gracenote Metadata Lookup Provider•	

Criar uma playlist
1	 No computador, inicie o programa 

Songbird.
2	 Escolha uma destas opções para criar 

uma nova playlist:
Na barra de ferramentas do •	
Songbird selecione File > New 
Playlist.
Clique com o botão direito do •	
mouse na barra lateral esquerda e 
escolha New Playlist.
Clique no símbolo •	 + na parte inferior 
do painel de serviços na lateral 
esquerda.
Uma nova playlist será exibida no »»
painel de serviços.

3	 Digite um nome para a nova playlist.

Adicionar títulos a uma playlist
1	 No computador, inicie o programa 

Songbird.
2	 Selecione um ou mais títulos.
3	 Escolha uma destas opções para adicionar 

os títulos selecionados a uma playlist:
Arraste os títulos selecionados e solte-•	
os na playlist no painel de serviços.
Clique com o botão direito do •	
mouse na seleção e marque Add to 
Playlist > Nome_da_playlist.
Todos os títulos selecionados são »»
adicionados à playlist.

Remover títulos de uma playlist
1	 No computador, inicie o programa 

Songbird.
2	 Selecione uma playlist.
3	 Clique com o botão direito do mouse 

no título que deseja remover e clique em 
Remove.

O título selecionado é removido da »»
playlist.

Alterar o visual da biblioteca 
do Songbird
Você pode alterar o design e o esquema de 
cores da biblioteca do Songbird. Chamamos 
esse recurso de “troca de plumagens”. As novas 
plumagens são instaladas e gerenciadas como 
complementos.
Encontrar novas plumagens
1	 No computador, inicie o programa 

Songbird.
2	 Na barra de ferramentas do Songbird, 

selecione View > Feathers > Get More 
Feathers….

O software pesquisa novas plumagens.»»

Siga as instruções on-line para instalar »»
os novos temas.
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todos os dados e músicas)
O Philips Songbird dispõe de um recurso de 

apagar todos os arquivos da memória interna.

Cuidado

O procedimento a seguir apaga todos os ••

1	 Instale o Philips Songbird no computador 
(consulte o capítulo Instalar software) e 
inicie o programa.

2	 No painel do Philips Songbird player, 

3	 No painel da biblioteca, clique na guia 
Tools (Ferramentas).

4	 No painel de ferramentas, clique em 
Format device (Formatar dispositivo).

5	 Siga as instruções na tela para executar o 
procedimento de reparo.

configurações de fábrica)
O Philips Songbird dispõe de um recurso de 
reparo que permite restaurar as configurações 

Antes de prosseguir, faça backup dos arquivos 

Cuidado

O procedimento a seguir apaga todos os ••

configurações de fábrica.

1	 Instale o Philips Songbird no computador 
(consulte o capítulo Instalar software) e 
inicie o programa.

2	 Na barra de menus do Philips Songbird 
(na parte superior), clique em Tools 
(Ferramentas) no menu suspenso e 
selecione  (Reparar meu 

3	 Siga as instruções na tela para executar o 
procedimento de reparo.

Formatar o SA2VBE (apagar 

formatação que permite formatar o SA2VBE e 

arquivos armazenados no SA2VBE.

clique em SA2VBE.

Reparar o SA2VBE (restaurar 

de fábrica do SA2VBE. 

armazenados no SA2VBE, se possível.

arquivos armazenados no SA2VBE e restaura as 

Repair My SA2VBE
SA2VBE).
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7	 Música

Ouvir músicas
1	 No menu principal, selecione  para 

entrar no modo de música.
2	 Navegue pelos submenus para selecionar 

a faixa de música.
3	 Pressione  para alternar entre 

reproduzir e pausar.
Pressione •	  para ver mais opções 
de música.
Pressione •	  para retornar um nível.
Pressione e segure •	  para retornar 
ao menu principal.

Navegar em uma faixa de 
música
1	 Enquanto estiver ouvindo uma faixa de 

música, pressione  /  para navegar 
rapidamente para frente/trás na faixa.

Pressione •	  para exibir mais opções 
de música.

Reproduzir músicas de uma 
seleção filtrada
1	 Enquanto estiver ouvindo uma música, 

pressione  e selecione [Modo de 
reprodução] > [Reproduzir músicas…].

2	 Selecione um filtro de seleção (exemplo: 
o filtro de seleção [… deste álbum] 
reproduz apenas as músicas do álbum 
que está sendo reproduzido).

»»
da seleção filtrada. 

Localizar músicas
No menu principal, selecione  para entrar no 
modo de música.

[Todas as músicas]
Faixas listadas em ordem alfabética•	

[Artistas]
Artistas listados em ordem alfabética•	
Álbuns listados em ordem alfabética•	
Faixas listadas de acordo com a ordem •	
do álbum

[Álbuns]
Álbuns listados em ordem alfanumérica•	
Faixas listadas de acordo com a ordem •	
do álbum

[Capa do álbum]
Álbum listado em ordem alfanumérica•	

[Playlists]
•	 [Playlist-on-the-go]

Faixas listadas de acordo com a ordem •	
da playlist

[Audiolivros]*
Livros listados em ordem alfanumérica•	

Nota

* Você pode adquirir audiolivros em lojas ••
online, como audible.com. 

••
música. 

Excluir a faixa que está sendo 
reproduzida
Este é o procedimento para excluir a faixa que 
está sendo reproduzida:
1	 Enquanto estiver ouvindo a faixa, 

pressione .
2	 Selecione a opção para excluir a faixa.
3	 Selecione [Sim] para confirmar a 

exclusão.

 

O SA2VBE reproduz apenas as músicas 

O  SA2VBE oferece as seguintes opções de menu:

O SA2VBE trata os audiolivros como arquivos de 
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Excluir uma ou mais faixas
Use o software Philips Songbird para 
sincronizar seus arquivos de mídia.
Você também pode excluir músicas no 
Windows Explorer:
1	
2	 No Windows Explorer, localize a pasta 

3	 Exclua as músicas como normalmente faz 
no computador.

Nota

Você também pode selecionar ••  no menu 
principal e localizar os arquivos no modo de 
exibição de pastas.

Conecte o SA2VBE ao computador.

de músicas no SA2VBE.
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8	 Audiolivros

O uso desse recurso requer o download 
do AudibleManager em audible.com. Com 
o AudibleManager, você pode gerenciar o 
conteúdo digital dos seus audiolivros.
Visite audible.com/gogear e registre-se. As 
instruções na tela o orientarão durante 
o processo de download do software 
AudibleManager.

•	 Importante:
de audiolivro  e .

1	 No computador, inicie o AudibleManager.
2	 Siga as instruções online para baixar os 

audiolivros no formato  ou .
3	 Siga as instruções do AudibleManager 

audiolivros. 
4	 Siga as instruções do AudibleManager na 

tela para transferir seus audiolivros para o 
������

Nota

••
quais esteja ativo.

Controles de audiolivros

modo de audiolivro:

Meta Ação
Reproduzir/Pausar Pressione 
Avançar para o início de 
uma nova seção/capítulo

Pressione 

Voltar para o início da 
seção/capítulo atual

Pressione 

Avançar rapidamente pelo 
audiolivro

Pressione e 
segure 

Retroceder rapidamente 
pelo audiolivro

Pressione e 
segure 

Menu de opções de 
acesso

Pressione 

Voltar para o menu de 
navegação

Pressione 

Aumentar/diminuir o 
volume

Pressione  
VOL 

Dica

Você pode reiniciar a reprodução de ••
audiolivros após interrompê-la (consulte a 
seção Reiniciar a reprodução neste manual do 
usuário).

Selecionar audiolivro pelo 
título do livro
1	 No menu principal, selecione  para 

entrar no modo de música.
2	 Pressione  ou  e  para selecionar 

[Audiolivros].
3	 Pressione  ou  para selecionar um 

título e  para reproduzi-lo.
Para•	  sair, pressione .

O SA2VBE suporta livros em formato de áudio. 

Adicionar audiolivros ao SA2VBE
 o SA2VBE suporta os formatos 

na tela para ativar o SA2VBE para os seus 

SA2VBE.

O SA2VBE só pode reproduzir audiolivros para os 

O  SA2VBE oferece os seguintes controles de 
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Adicionar um marcador a um 
audiolivro
1	 No modo de reprodução de audiolivro, 

pressione .
2	 Pressione  ou  e  para selecionar 

[Marcadores].
3	 Pressione  ou  e  para selecionar 

[Adicionar marcador].
Será exibida uma tela de confirmação.»»

Para sair, pressione •	 .

Localizar um marcador em 
um audiolivro
1	 No modo de reprodução de audiolivro, 

pressione .
2	 Pressione  ou  e  para selecionar 

[Marcadores].
3	 Pressione  ou  e  para selecionar [Ir 

para marcador].
4	 Pressione  ou  para selecionar o 

marcador na lista.
5	 Pressione  para ir para o marcador 

selecionado.
Para sair, pressione •	 .

Excluir um marcador de um 
audiolivro
1	 No modo de reprodução de audiolivro, 

pressione .
2	 Pressione  ou  e  para selecionar 

[Marcador [x]].
3	 Pressione  ou  e  para selecionar 

[Excluir marcador].
4	 Pressione  ou  para selecionar o 

marcador na lista.
5	 Pressione  para excluir o marcador 

selecionado.
Para sair, pressione •	 .
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9  Vídeo

Reproduzir vídeos
1 No menu principal, selecione  para 

entrar no modo de vídeo.
2 Navegue pelos submenus para selecionar 

o vídeo.
3 Pressione  para alternar entre 

reproduzir e pausar.
Pressione •  para ver mais opções 
de vídeo.
Pressione •  para retornar um nível.
Pressione e segure •  para retornar 
ao menu principal.

Navegar em um vídeo
1 Enquanto estiver assistindo a um 

vídeo, pressione  /  para navegar 
rapidamente para frente/trás no vídeo.

Pressione •  para exibir mais opções 
de vídeo.

Excluir o vídeo que está 
sendo reproduzido
Este é o procedimento para excluir o vídeo 
que está sendo reproduzido:
1 Enquanto estiver assistindo ao vídeo, 

pressione .
2 Selecione a opção para excluir o vídeo.
3 Selecione [Sim] para confirmar a 

exclusão.

Excluir um ou mais vídeos
Use o software Philips Songbird para 
sincronizar seus arquivos de mídia.
Você também pode excluir músicas no 
Windows Explorer:
1 

2 No Windows Explorer, localize a pasta 

3 Exclua o vídeo como normalmente faz no 
computador.

Nota

Você também pode selecionar  •  no menu 
principal e localizar os arquivos no modo de 
exibição de pastas.

Conecte o SA2VBE ao computador.

de vídeos no SA2VBE.

Seu Philips SongBird está em constante melhoria,
incorporando sugestões dos usuários para o
melhor desempenho e reprodução da maior
variedade de formatos.
Para desfrutar ao máximo de tudo isso:
       

  

     
               

1

2 Baixe e instale gratuitamente o Apple
Quicktime (www.apple.com/br/
quicktime/).

3 Mantenha os seus complementos
atualizados. Basta clicar em
Ferramentas> Complementos>
Localizar atualizações

No Windows, há suporte para WMVe com
o QuickTime instalado, ainda há suporte a
MPEG-4 e H.264 em MP4.
Extensão             Windows            MacOS      
de arquivo    
    ogv                Sim                   Sim
   wmv                Sim           Não
   mp4              Com o                Sim
                          Quicktime 
                         instalado, sim     
   m4v                  Com o                Sim             
(exceto               Quicktime
arquivos DRM     instalado, sim
da loja do
iTunes)  
   mov              Com o                Sim
                         Quicktime
                       instalado, sim           

       Mantenha seu Philips Songbird
       atualizado. Sempre que você usa o
       Songbird, ele procura por novas versões e
       atualizações.
Para conferir se o seu Songbird está atualizado,
clique em: Ajuda> Procurar por atualizações...
Você então será notificado ou de que o seu
Songbird está atualizado ou será guiado pelo
menu simples de atualização.

Copyright © 2010 Apple Inc. Todos os direitos reservados.

Nota

Resolução de vídeo suportado
MJPEG (.mp4): 128 x 128 pixels, 30 qps, 512 kbps.
 •
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10 Imagens

1 
2 No Windows Explorer, crie pastas no 

3 Use as ações de arrastar e soltar para 
organizar as imagens nas pastas.

Exibir imagens
1 No menu principal, selecione  para 

entrar no modo de imagem.
2 Navegue pelos submenus para selecionar 

a imagem.
3 Pressione  para exibir a imagem.

4
 Pressione •  para ver mais opções 

de imagem.
Pressione •  para retornar um nível.

Pressione e segure •  para retornar 
ao menu principal.

Iniciar uma apresentação de 
slides
1 Enquanto você assiste a um vídeo no 

modo de tela cheia, pressione  para 
iniciar uma apresentação de slides.

Pressione •  para exibir mais opções 
de apresentação de slides.

Excluir a imagem que está 
sendo exibida
Este é o procedimento para excluir a imagem 
que está sendo exibida:
1 Durante a exibição da imagem no modo 

de tela cheia, pressione .
2 Selecione a opção para excluir a imagem.
3 Selecione [Sim] para confirmar a 

exclusão.

Excluir uma ou mais imagens
Use um computador para excluir imagens no 
Windows Explorer:
1 
2 No Windows Explorer, localize a pasta 

3 Exclua as imagens como normalmente faz 
no computador.

Nota

Você também pode selecionar  •  no menu 
principal e localizar os arquivos no modo de 
exibição de pastas.

Adicionar imagens ao SA2VBE
Conecte o SA2VBE ao computador.

SA2VBE.

Conecte o SA2VBE ao computador.

de imagens no SA2VBE.
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11	Rádio

Ouvir rádio FM
1	 No menu principal, selecione  para 

entrar no modo de rádio.
O cabo dos fones de ouvido funciona »»
como antena FM. 

Dica

A reprodução do rádio pára quando você ••

Sintonizar manualmente uma 
estação de rádio
No modo , você pode sintonizar 
manualmente uma estação de rádio:
1	 Para pesquisar o próximo sinal mais forte, 

pressione e segure  / .
2	 Para sintonizar a freqüência, pressione 

rapidamente  / .

Pré-sintonizar estações rádio 
automaticamente

ajuda a localizar estações de rádio e as salva em 
números predefinidos.
1	 No modo , com os fones de ouvido 

conectados, selecione uma pré-sintonia.
2	 Pressione  e selecione [Sintonia 

automática]. 
Se solicitado, selecione •	 [Sim] para 
confirmar.
O rádio sintoniza automaticamente »»
estações de rádio e salva as 
freqüências em números predefinidos. 
Existem 20 números predefinidos 
disponíveis.
Para interromper a sintonia •	
automática, pressione .
Para retornar ao menu principal, •	
pressione e segure  por 2 
segundos.

Selecionar uma estação de 
rádio pré-sintonizada
1	 No modo , selecione uma pré-sintonia.
2	 Pressione  ou  para alterar para outra 

pré-sintonia.
3	 Para pesquisar o próximo sinal mais 

forte, pressione e segure  ou  por 2 
segundos.

Para retornar ao menu principal, •	
pressione e segure  por 2 
segundos.

Nota

Para reproduzir estações de rádio pré-••
sintonizadas, primeiro você precisa armazená-
las em pré-sintonias.

alterna para outro modo ou desliga o SA2VBE.

O recurso de sintonia automática do SA2VBE



26 PT-BR

12 Gravações

Gravar áudio/voz
Como gravar áudio/voz usando o microfone 
embutido (consulte a seção Visão geral para 
saber onde está o microfone embutido):
1 No menu principal, selecione  > [Iniciar 

gravação de voz].
Pressione •  para alternar entre 
pausar e gravar.

2 Pressione  para parar.
3 Pressione  para salvar a gravação ou 

pressione  para cancelar.
As gravações são salvas no aparelho.  »
(Formato de nome de arquivo: 
VOICEXXX.MP3, sendo XXX 
o número da gravação gerado 
automaticamente.)

Dica

As gravações ficam armazenadas em  •
[Biblioteca de gravações] > [Voz].

Ouvir gravações
Ouvir gravações de voz/áudio:
1 No menu principal, selecione .
2 Pressione  e selecione [Biblioteca de 

gravações] > [Gravações de voz]..
3 Selecione uma gravação.
4 Pressione  para reproduzir a gravação.

Transferir as gravações para o 
computador
Use o software Philips Songbird para 
sincronizar seus arquivos de mídia.
Você também pode transferir gravações no 
Windows Explorer:
1 
2 
3 Selecione a pasta Recordings > Voice ou 

FM radio* (Gravações > Voz ou Rádio 
FM).

4 Copie as gravações e cole-as no local 
desejado no computador.

Nota

* O recurso de gravação de rádio FM está  •
disponível somente em algumas versões. 

quais são os recursos disponíveis.

Excluir o vídeo que está 
sendo reproduzido
Este é o procedimento para excluir a gravação 
que está sendo reproduzida:
1 Enquanto estiver ouvindo a gravação, 

pressione .
2 Selecione a opção para excluir a gravação.
3 Selecione [Sim] para confirmar a 

exclusão.

Conecte o SA2VBE ao computador.

No Windows Explorer, abra o SA2VBE.

Consulte o menu na tela do SA2VBE para saber 



27

Po
rt

ug
uê

s

PT-BR

Excluir uma ou mais 
gravações
Este é o procedimento para excluir gravações 
no Windows Explorer :
1	
2	 No Windows Explorer, localize a pasta 

Recordings > Voice ou FM radio* 
(Gravações > Voz ou Rádio FM).

3	 Exclua as gravações como normalmente 
faz no computador.

Nota

* O recurso de gravação de rádio FM está ••
disponível somente em algumas versões. 

quais são os recursos disponíveis.

Conecte o SA2VBE ao computador.

Consulte o menu na tela do SA2VBE para saber 
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13	
para transportar 
arquivos de 
dados

armazenar arquivos de dados e transportá-los:
1	

a seção Conectar e carregar para obter 
instruções).

2	 No computador, no Windows 
Explorer,copie os arquivos de dados e 

Dica

Use o computador para transferir arquivos de ••
dados para o próprio computador ou excluí-

Usar o SA2VBE

Este é o procedimento para usar o SA2VBE para 

Conecte o SA2VBE ao computador (consulte 

cole-os no SA2VBE.

los do SA2VBE.
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14 Configurações
Este é o procedimento para personalizar o 

No menu principal, selecione  para entrar no 
modo de ajustes.
No menu  navegue da seguinte maneira:
1 Pressione  /  para selecionar uma 

opção.
2 Pressione  para confirmar a seleção e ir 

para o próximo nível (se disponível).
Pressione •  para retornar ao nível 
anterior.
Pressione e segure •  para fechar o 
menu .

No menu , as seguintes opções estão 
disponíveis:

Configurações Menu de opções Menu de sub-opções
Modo de reprodução Reproduzir músicas... Todas as músicas• 

...deste álbum• 

...deste artista• 
Repetir Repetição desligada (padrão)• 

Repetir 1• 
Repetir tudo• 

Aleatório Aleatório desligado (padrão)• 
Tudo aleatório• 

Definições de som FullSound Desligado (padrão)• 
Ligado*• 

Equalizador Desligado (padrão) • 
Rock• 
Funk• 
Hip hop• 

Jazz• 
Clássico• 
Techno• 
Pessoal• 

Limite de volume Desligado (padrão)• 
Definir• 

SA2VBE:

 
Timer desl. aut. Tempo restante: [x] min

Desligado (padrão)
Definir
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Configurações Menu de opções Menu de sub-opções
Configurações do display Brilho

Tema
Preto (padrão)• 
Azul• 
Vermelho• 

Timer de luz de fundo 15 s (padrão)• 
30 s• 
45 s• 
Sempre ligado•

Language/Português
              Brasileiro

Tcheco• 
Grego• 
Inglês (padrão)• 
Dinamarquês• 
Alemão• 
Espanhol• 
Francês• 
Italiano• 
Húngaro• 
Holandês• 

Norueguês• 
Polonês• 
Português (Portugal)• 
Português (Brasil)• 
Russo• 
Eslovaco• 
Finlandês• 
Sueco• 
Turco• 
Chinês simplificado• 

Chinês tradicional• 
Japonês• 
Coreano• 
Tailandês (algumas • 
versões apenas)
Árabe (algumas • 
versões apenas)
Hebraico (algumas • 
versões apenas)

Informações Capacidade
Espaço livre
Versão firmware
Modelo
Site de suporte

Configurações padrão Restaurar 
configurações 
padrão? (Os arquivos 
não são afetados.)

Sim• 
Não• 

*O equalizador é desativado quando FullSound 
é selecionado.

Data e hora Ajuste de hora
Ajuste de data

Def. da apr. de slides Tempo por slide
Repetir
Aleatório

Preferência de conexão
com PC

MSC
MTP

Legal

Formatar dispositivo
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15	Dados técnicos
Alimentação
Fonte de alimentação: bateria interna 
recarregável de polímero de íon e lítio de 
������� mAh
Tempo de reprodução¹ 
- música: ���������������� horas
- vídeo: 4 horas
Software
Philips Songbird: para atualizar firmware e 
transferir músicas
Conectividade
Fone de ouvido com plugue de 3,5 mm 
USB 2.0 de alta velocidade
Som
Separação de canais: 45 dB
Resposta em freqüência: 80 - 18.000 Hz
Potência de saída (RMS): 2 x 2,4 mW
Relação sinal/ruído: > 84 dB
Reprodução de áudio
Formatos suportados:
MP3:
Taxas de transferência de MP3: 8 - 320 kps 
e VBR
Taxas de amostragem de MP3: 8, 11.025, 16, 
22.050, 32, 44,1, 48 kHz
WMA:
Taxas de bits de WMA: 5 - 320 kbps
Taxas de amostragem de WMA: 8, 11.025, 
16, 22.050, 32, 44,1, 48 kHz
WAV
FLAC
APE
Reprodução de vídeo
Formatos suportados:
MP4
MJPEG (em .mp4)
Exibição de imagens
Formatos suportados:
JPEG
BMP

Mídia de armazenamento
Capacidade da memória interna²:

Nota

¹ Baterias recarregáveis têm um número ••
limitado de ciclos de carga. A vida útil da 
bateria e o número de ciclos de carga variam 
de acordo com o uso e as configurações. 
² 1 GB = 1 bilhão de bytes; a capacidade ••
de armazenamento disponível é menor. 
Não é possível contar com a capacidade de 
memória total porque parte da memória é 
reservada para o player. A capacidade de 
armazenamento é baseada em 4 minutos por 
música e 128 kbps de codificação MP3.

Requisitos do sistema
Windows® XP (SP3 ou superior) / Vista •	
/ 7
Processador Pentium III 800 MHz ou •	
superior
512 MB de RAM•	
500 MB de espaço no disco rígido•	
Conexão com a Internet•	
Windows® Internet Explorer 6.0 ou •	
posterior
Unidade de CD-ROM•	
Porta USB•	

SA2VBE04 4 GB de NAND Flash
SA2VBE02 2 GB de NAND Flash

SA2VBE08 8 GB de NAND Flash
SA2VBE16 16 GB de NAND Flash
SA2VBE32 32 GB de NAND Flash
Display
LCD em cores de 128 x 128 pixels128 x 128 pixels pixels
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16	Glossário

C
Compressão
Em áudio, é um processo de redução, 
temporária ou permanente, dos dados 
de áudio, para obter mais eficiência no 
armazenamento ou transmissão. Uma redução 
temporária no tamanho do arquivo é chamada 
de compressão ‘sem perdas’ e não há perda 
de informações. Uma redução permanente 
no tamanho do arquivo (como nos arquivos 
MP3) é chamada de compressão ‘com perdas’ 
e envolve descartar informações menos 
relevantes, que são perdidas para sempre.

Compressão sem perdas
Sistema para reduzir o número de bits de 
dados (densidade) em um sinal musical sem 
alterar o original.

Copiar (cópia)
Utilização de um programa de software 
que “captura” o áudio digital de um CD e o 
transfere para uma unidade de disco rígido 
do computador. A integridade dos dados 
é preservada, pois o sinal não passa pela 
placa de som do computador e não precisa 
ser convertido em um formato analógico. 
A transferência digital para digital cria um 
arquivo WAV que pode ser convertido em 
MP3.

D
Decibel (dB)
Uma unidade de medida usada para expressar 
a diferença relativa de energia ou intensidade 
de som.

F
FM (Freqüência modulada)
Em radiodifusão, um método de modulação 
em que a freqüência da tensão da emissora 
varia com a freqüência da tensão de 
modulação.

FullSound
FullSound™ é uma tecnologia inovadora 
criada pela Philips. FullSound™ recupera com 
fidelidade os detalhes sonoros de música que 
foi comprimida, aprimorando sua qualidade 
para proporcionar uma experiência sonora 
sem nenhuma distorção. 

L
LCD (Tela de cristal líquido)
Provavelmente o tipo mais comum de 
dispositivo de informações visuais usado 
em equipamentos eletrônicos que não são 
computadores.

M
MP3
Formato de arquivo em um sistema de 
compressão de dados sonoros. MP3 é a 
abreviação de Motion Picture Experts Group 
1 (ou MPEG-1) Audio Layer 3. No formato 
MP3, um CD-R ou CD-RW pode conter 5 a 
10 vezes mais dados que um CD de áudio. 

MSC [Mass Storage Class, Classe de 
armazenamento em massa]
A classe de dispositivo USB de 
armazenamento em massa (ou USB MSC 
ou UMS) é um conjunto de protocolos 
de comunicação computacionais que 
fornecem uma interface a dispositivos de 
armazenamento. Dispositivos que suportam 
esse padrão são conhecidos como dispositivos 
MSC (Mass Storage Class, Classe de 
armazenamento em massa).
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MTP [Media Transfer Protocol, Protocolo de 
transferência de mídia]
O Media Transfer Protocol (Protocolo de 
transferência de mídia) suporta a transferência 
de arquivos de música e vídeo para aparelhos 
portáteis de áudio/vídeo.

R
Resposta de freqüência
É a faixa de freqüências reproduzida por 
um alto-falante, da menor freqüência até a 
maior. Embora a faixa de audição ideal seja 
de 20 Hz até 20.000 Hz (Hertz), a maioria 
das pessoas não ouve em toda essa faixa. Mas 
um bom sistema de alto-falantes reproduz 
a maior parte possível desta faixa, para 
atender à capacidade de audição de todas as 
pessoas. Cada alto-falante individual limita-se 
a reproduzir apenas a parte do espectro de 
freqüências para a qual foi fabricado, então 
sua resposta é limitada a essas freqüências, e 
esse é um ponto que deve ser considerado ao 
se projetar um sistema de som completo.

S
SuperScroll
SuperScroll™ é um recurso de navegação das 
teclas de busca de ação dupla do produto. O 
SuperScroll™ permite um controle fácil de 
velocidade ao percorrer grandes bibliotecas, 
para localizar facilmente os itens desejados. 
Quanto mais tempo o botão for pressionado, 
mais rápida será a rolagem.

T
Taxa de bits
A taxa de bits é o número de bits enviados 
ou processados por unidade de tempo. A taxa 
de bits geralmente é medida em múltiplos de 
bits por segundo (kilobits por segundo: kbps). 
O termo taxa de bits é o mesmo que taxa de 
transferência de dados (ou simplesmente, taxa 
de dados). 
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